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5 Driver Software Operations 
The Keynes Controls NetPod manager software is the package provided by Keynes Controls 
when you purchase any of our network products. The software operates under Microsoft 
Windows 95, 98, 2000 and NT operating systems. The following operations are supported: 

 
Password Protected Operating Environment 
Starting & Stopping data acquisition operations. 
Channel Configuration. 
Data Recording. 
Calibration Operations. 
Sensor Selection. 
Multi-user operations. 
Real Time Display 
Multi-instrument Operations. 
 

All of the graphical operations of the driver are identical no matter which network is being used to 
gather data. 

Upon installing the driver software and up on initialisation, the NetPod manager scans the serial 
and local area network interfaces within the host system for Pod traffic. If any traffic identified as 
originating from NetPod instruments then the software auto-configures the instruments for 
operation. All the user need do is to assign channel names to the instruments that can be used to 
easily identify the source of data. 

5.1 Password Protected Operating Environment 

The PodMng driver software provides a password protected operating environment. There are 
two modes of operation Admin and Operator.  

Operator mode enables data to be presented to third party applications software but prevents any 
changes of configuration and data transmission operations from the driver of third party software. 
You cannot change any instrument configurations or start and stop the data transmissions. 
Operator mode operations are ideal where you require terminals to display data only. 

Admin Mode enables full configuration of the instruments. You can select and configure any 
instrument operation.  
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5.2  Software Mode Changes 

To change the mode of operation of the driver software: 

 
From the Default PodMng Window select   File > Access Control 

 

User

 
Figure 13 PodMng -  Access Control Window 

 

The Access Control Window will appear. Enter your password. 
 
Select the Mode of  Operation 
 
Press the OK button to activate the mode change.   

 
When the Access Control Window disappears you have changed operating modes.  
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5.3 Starting and Stopping Global Data Acquisition Operations 

The driver software allows the user to have full control of all aspects of the data acquisition 
operations of the instruments. You can start and stop all data acquisition operations for all 
instruments simultaneously across a network or individually to a dedicated unit. The aim of this 
section is to describe the data acquisition operations that control all instrument operations 
simultaneously across a network, for the purpose of this manual called global data acquisition 
operations. 

The status of the data acquisition operations can be clearly seen directly from the instrument status 
lights and from the driver by the colour of the task bar icon. The task bar icon is coloured green 
when data transmission operations are active and red when no data is present. See images below 

 
 

 

Starting Global  Data Transmission Operations 

The following section shows the instruction to 
follow to start global data acquisition operations ie 
start all instruments up on a network to broadcast 
data. 

 
1. From the main menu select the FILE menu item. 
 
2. Using the mouse pointer or cursor keys select the Run Mode menu item. 
 

 
Figure 16 PodMng Software - Run Mode Active 

 
 A tick mark will appear adjacent to the Run Mode menu option. The tick mark is used to indicate that 

data recording and control operations are under way. 
 
3. The File menu options will disappear and the main menu be displayed.  You can now carry out any 

further operations. 
 

  
 

 
 

Figure 14  Task 
bar icon - Data 
Transmission 
Active 
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 Note. In order to check the status of the logging operations from the NetPod manager simply select the 
FILE menu option  from the main display.  You will see a series of menu items displayed on the screen 
, one of them being the Run Mode option. 

 
 If a  tick mark is displayed adjacent to the Run Mode menu item then data acquisition operations are 

underway. 
 
 The task bar icon will appear to be flashing green in colour. 

 
Stopping  Data Transmission Operations 
 

The following section shows the instruction to follow to start global data acquisition 
operations ie start all instruments up on a network to broadcast data. 

 
 
1. From the main menu select the FILE menu option. 
 
2. Using the mouse pointer or cursor keys select the Run Mode menu item. 
 
 The tick mark which appears adjacent to the Run Mode menu item will disappear. 
 

 

 
Figure 17  PodMng Software - No Data Acquisition Stopped 

 
 A tick mark  is used to indicate that data recording and control operations are active and that data may 

be in the process of being recorded.  
 
3. The File menu options will disappear and the main menu be displayed.  You can now carry out any 

further operations. 
 

The instrument Tx and Rx LEDs will stop flashing (LAN operations only) 
 
The task bar icon will appear to be flashing green in colour. 
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5.4 Starting and Stopping Data Acquisition Operations for a Specified Instrument 

 

The following section describes the operations to follow to start and stop data acquisition 
operations for a single specified instrument. These operations are meant as an aid to testing the 
network prior to acquisition operations are overridden by the use of global acquisition commands.  

 

 

 

Figure 18  - Start and Stop acquisition - menu options 
 

Stopping Data Acquisition Operations for Specified Instrument. 

 

1. Ensure that the driver is active and receiving data. The task bar icon should be flashing 
green 

2. From the main driver window (as above) select the instrument whose data acquisition 
operation you want to suspend (stop) using left hand mouse. 

3. Once you have selected the instrument whose data transmission operations you want to 
suspend press the right hand mouse button. You will observe a menu appear adjacent to 
the selected instrument with the following options: EDIT, RESET, DIGITAL, 
ENABLE WT, START NetPod, STOP NetPod 

 

4. Select “ Stop NetPod” option – you will observe the Tx status light on the instrument is 
off.  

 

5. The Error log will report  Time (00:00:00)  Pod-id disabled 
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Starting Data Acquisition Operations for Specified Instrument. 

 

1. Ensure that the driver is active and receiving data. The task bar icon should be flashing 
green 

 

2. From the main driver window (as above) select the instrument whose data acquisition 
operation you want to activate (start) using left hand mouse. 

 

3. Once you have selected the instrument whose data transmission operations you want to 
activate press the right hand mouse button. You will observe a menu appear adjacent to 
the selected instrument with the following options: EDIT, RESET, DIGITAL, 
ENABLE WT, START NetPod, STOP NetPod 

 

4. Select “ Start NetPod” option – you will observe the Tx status light on the instrument is 
now active.  

 

5. The Error log will report   “Time (00:00:00)  Pod-id Enabled” 

 

REMEMBER – activating logging from the driver for all units will over ride 
these actions. 
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5.5 Configuring the Analogue Input Channels 

The following instructions detail the procedures followed to assign channel configuration details 
for use within the Pod Manager software package: 

From the main menu select a Pod whose channel you want to configure. 

 

              
Figure 19  PodMng Software - Default Screen (Multi-user operations) 

 

The Window shown above is the main configuration Window that appears when the PodMng 
software first activated and the network scanned in a multi-instrument environment. Each of the 
NetPod instruments for which data traffic has been identified will be shown on the main screen 
below the title listing the interface upon which traffic was detected.  

For data originating from instruments connected to the RS-485 or RS-232 serial ports then the 
interface named on the main configuration menu will be titled Ports. For data identified as 
originating from the 10 Base-2 or 10BaseT  interfaces then the titled Ethernet.   

 
1 Move the mouse pointer over the Pod chosen for channel configuration. Select by pressing the left hand 

mouse button either the + symbol; which appears adjacent to the Pod for which channel details are 
going to be adjusted, or directly the channel  which is going to be configured. 

 
 NOTE. 
 
 On selecting the + symbol. The channel details associated with the chosen pod will be listed. The Pod 

manager software will interrogate all identified units and report details of any analogue and digital 
interface cards installed within the instruments.  

 
 
2. Move the mouse pointer until it is above the channel name which has been selected for configuration.  
 
 Double click the left hand mouse button. The Edit Channel window will appear.  If you do not double 

click the left hand mouse button quickly enough then only the text on the menu will change. The text 
will change from black on a white background to white on a blue background. 
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Figure 20  PodMng Software - Edit Channel Window 

 
3 Using either the Tab key or mouse pointer, select the parameter that is to adjusted.  
 
4 On completing the channel configuration details select the "OK" button. All of the newly configured 

parameters will now take effect. 
 

 
Figure 21  PodMng Software - Confirm Window 

 
  
 
 
 
 
 

NOTE. 
 
 If at any time you want to stop the configuration process simply select  the "Cancel" button on the Edit 

Pod menu. The Edit Pod menu will disappear and you will return to the main system configuration 
menu. 

 

Manufacture
&

Warranty
Information

Global
setup

details

Sensor setup

Channel Number - used to show which channel
(0-15) is being configured.

Interface Part Number 

ADC Type - Auto-detected and displayed

Interface Serial Number

Manufacture date of analogue channel

Channel Name - used to identify channel within
driver software. Often describes source of data 
connected to input 

Input pre-amp gain setting. 

Resolution of analogue input 

Activate Calibration Window

Activate sensor
setup window
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5.6 Setting the Sample Rate 

The following section details the operations that are to be undertaken to set the sample rate of the 
NetPod. Unlike most data acquisition systems the NetPod supports multiple sample rate 
operations. 

5.7 Multi-Rate Data Acquisition 

NetPod enables multi-rate sampling to be undertaken across a network. You cannot mix sample 
rates directly within a single unit but you can have multiple units running on a network operating 
at different rates.  For example, if you have three units on a network, Pod-1 can operate at 1 KHz, 
Pod-2 at 500 Hz, and Pod-3 at 10 Hz. There are no limitations on how you mix the sample rates. 
You can choose any option specified on the sample rate setup menu. The sample rates at which 
are unit will operate are automatically determined and are based upon the technical specifications 
of the input modules.  

5.8 Data Decimation 

In order that you can undertake multi-rate data processing  for analogue channels contained within 
the same unit, you will have to develop you own processing software. A drivers developers kit has 
been created to enable you to design you own applications and utilise the functionality within the 
instruments 

To set the sample rate of a chosen NetPod unit follow the instructions specified below 

5.9 Sample Rate - Instructions. 

Using either the Config or Podmng software, stop the data transmission operations across the 
network. 

For sample rate changes the data transmission operations must be stopped regardless of type of 
network from which data is being acquired. The Podmng software displays a green flashing icon 
while data is being broadcast by NetPod instruments across a network. The Podmng software 
displays a red icon when data transmission operations are suspended.   

 
 1) Display the Default driver menu. 

 
Move the mouse pointer until it is above the Podmng icon. Press the Right hand mouse button. 
 
Select the Config menu option. 
 

2) The Default driver screen will appear.  Select the NetPod unit whose sample rate you want to adjust. 
 
Move the mouse pointer until it is directly above the NetPod icon whose sample rate you want to adjust.  
 
Double click the left hand mouse button. 
 

3) The Edit Pod window will appear. Note.  It is using the Edit Pod Window that the sample rate can be 
adjusted. 

 
 
4) Using the mouse pointer or Tab key select the Sample Rate pull down menu list. 

 
Once you have selected the Sample Rate pull down menu, you can select the new sample rate by using the 
Up and Down cursor keys to adjust the highlight bar or by simply selecting the new rate directly by the 
mouse pointer. 
 

5) Once you have selected the new sample rate press the OK button. The Confirm screen will appear. 
 
6) Select the OK button on the Confirm screen to store new sample in the specified pod. 

 
Once you re-start the data transmission operations the new sample rate will take effect. 



NetPod User Manual Version 1.10 Copyright  Keynes Controls 2005 - 2006 Page 45 
 

 

 

 

5.10 Multi-user Operations 

The standard driver supports multi-user operations. Simply load the driver software on to the 
additional PCs using the CD supplied with the instrument. The software for multi-user operations 
is generally supplied in two parts. The standard driver i.e. PodMng is provided for general 
purpose operations, diagnostics and instrument configuration. Third party drivers are supplied to 
integrate data from the instruments directly into applications packages.  

When operating in a multi-user environment the PodMng software will appear in just the same 
way as described for single user operations. The software automatically determines the state of the 
data emissions from the instruments on a network. If data transmissions from the instruments is 
detected the task bar icon colour changes from red to green. 

 

   
Figure 22 - Taskbar Operations Indication 
 

Depending upon which mode of operation you are using, i.e. Admin mode or User Mode (See 
Section 4.3). you can configure the instruments, start and stop data transmissions and record data 
directly from each User’s terminal. Most third party drivers call the NetPod.dll to transmit and 
receive configuration details to and from the instruments.   

The control of the instruments is a global operation i.e. effects all users and instruments. Starting 
and stopping data transmissions and configuration changes are reflected directly to each user 
connected to the network. The driver software automatically detects any changes and updates 
each user automatically. There are no configuration files to maintain. The automatic updating of 
the Keynes Controls software is not necessarily a feature of third party packages. 
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5.11 Real Time Data Display 

 
To observe real time data from any of the instruments on the network follow the instruction 
below. You must ensure that that the network data transmission operations are active. 

 
1) At the PodMng Window select  View window option 
 
 The Display window will appear 
 
2) The Display window has the following Tab options. Graph, Raw, Processed Errors 
 
3) Select the Graph Tab  The  Chart Recorder display will appear. 
 
 

 

                
Figure 23  PodMng Software - Chart Recorder Display 

 
4) You can observe data from any instrument on the network.  Using the Channel selection guide select 

the instrument and channel whose data you require to plot. 
 
5) For each channel you are using select either Raw or Processed data type options.  You can mix raw and 

processed data on the screen. 
 

Display Selection Tabs

Grid Selector - When tick mark 
displayed grid is shown on 
chart recorder screen.

Real-time data plot

Axis range slider bars

Pause button - freazes 
current display.

Channel selection guide
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5.12 Text Display - Raw and Process Data 

 
To observe the raw and processed data in a text format follow the instructions below: 

 
1) At the Display Window (See Figure 20) select the Text (Raw) or Text (Processed) tab.  
 
 You will see a display similar to the one shown below. 

           
Each instrument will be listed horizontally across the screen  

 
Listed below each instrument will be the data from the analogue input channels. A  blank space in the 
channel list shows that no channel is installed in the instrument.  

 
The display should match directly the configuration of your channels in the instruments.  

 
When you have finished with the display. Close the Display window. Closing the window does 
not stop the driver from operating. No data is lost if your are streaming results to disk. 

Instrument Names

Analogue
Input

Channels 

Display Selection Tabs

 
Figure 24  PodMng Software - Real Time Text Display 
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5.13 Channel Configuration - Edit Channel Menu 

The following instructions detail the procedures to be followed to assign channel configuration 
details for use within the Pod Manager software package: 

 
1. From the main menu select a Pod whose channel you want to configure. 
 
 NOTE. 
 

 The main configuration menu  is the menu that appears when you first activate the NetPod manager 
software. Each of the NetPod instruments for which data traffic has been identified will be shown on 
the main screen below the title listing the interface upon which traffic was detected. For data 
originating from instruments connected to the RS-485 or RS-232 serial ports then the interface named 
on the main configuration menu will be titled Ports. For data identified as originating from the 10 
Base-2 or 10BaseT  interfaces then the titled Ethernet.   

 
2. Move the mouse pointer over the Pod chosen for channel configuration. Select by pressing the left hand 

mouse button or the + symbol; which appears adjacent to the Pod for which channel details are going to 
be adjusted, or directly the channel  which is going to be configured. Figure 15 shows the Edit 
Channel Window 

 
 NOTE. 
 
 On selecting the + symbol. The channel details associated with the chosen pod will be listed. The Pod 

manager software will interrogate all identified units and report details of any analogue and digital 
interface cards installed within the instruments.  

 
3. Move the mouse pointer until it is above the channel name which has been selected for configuration.  
 
 Double click the left hand mouse button. The Edit Channel window will appear.  If you do not double 

click the left hand mouse button quickly enough then only the text on the menu will change. The text 
will change from black on a white background to white on a blue background. 

 
4. Using either the Tab key or mouse pointer, select the parameter that is to adjusted.  
 
5. On completing the channel configuration details select the "OK" button. All of the newly configured 

parameters will now take effect. 
 
 NOTE. 
 
 If at any time you want to stop the configuration process simply select  the "Cancel" button on the Edit 

Pod window. The Edit Pod Window will disappear and you will return to the main system 
configuration menu. 
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5.14 Multi-instrument Operations 

The NetPod supports multi-instrument operations on the 10Base2/10BaseT and RS-485 networks. 
NetPod has been designed for operation on Ethernet networks and it is with this type of network 
that the main benefit of the instrumentation will be achieved. 

To install additional instruments to a 10BaseT network simply power on the instrument and 
connect the twisted pair network cable from the hub to the NetPod RJ45 socket. Instantly the 
instrument detects network data you will see the link status light illuminate. The Link status light 
is one of the LEDs mounted on the front panel of the unit. You must ensure that each instrument 
has its own unique IP address before connecting onto a network. 

The addition of further instruments to a 10Base2 network is also a simple operation. This time 
instead of connecting the twisted pair cable as described for 10BaseT operations, simply connect 
the 10base2 Ethernet string to the instrument via the BNC connector using the a T piece. 
Remember, if the instrument is the last unit on the Ethernet string you must ensure that the 50 
Ohm end terminator is connected.  

When using 10Base2 network, the link status light does not function. You have to use the software 
to show that instrument is connected to the network and operating correctly. Figure 14 shows a 
typical PodMng Window in multi-instrument operation. 

5.15 Data Recording Operations 

The following page details the instructions that should be followed to store data to disk. Each user 
can record data using the PodMng software or third party application packages. 

 
1) From the main menu select the Configure menu option 
 
2) Select the Logging menu item to access the data recording operations setup screen. 
 

 
Figure 25  PodMng Software - LoggingCfg Window 

 
 Using the LoggingCfg setup dialog box simply enter the file names and directory locations where you 

want to store processed and raw data. 
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Processed Data:  This is data converted into engineering units by a mathematical process. 
 
Raw data:            This is the data  gathered by  the NetPod instruments prior to any data processing 

 
3) Enter in the “Rate (Sample/sec)” boxes the desired sample rate.  

 
Only enter sample rates up to the maximum rate set for the NetPod instrumentation. The recording of 
data does not include any multi-rate filtering  to eliminate aliasing effects.  
 

4) Using the mouse pointer select the desired type of recording operations. 
 

Active: Data is recorded to a new file each time storage operations are activated. Old files are over 
written. 

 
Append: Data is appended to the end of the specified file at the resumption  of data recording 

operations. 
 

Move the mouse pointer over the data recording function tick boxes. Use the left mouse button to select 
the desired option. You can only select one option at any one time for either of the raw and processed 
data file. 
 

5) Once you have completed the setup operations select the OK button. The LoggingCfg Window will 
disappear and you will return to the default screen. 
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5.16 Error Recording  

Error recording is useful to show the status of the instruments and network operations for a series 
of instruments widely separated on an Ethernet network. It is possible to locate and in may cases 
identify the source of any system error with out need of manually inspecting the instruments. 

The following page details the instructions that should be followed to record the instrument and 
network error messages  to disk. Each user can record an error log  using the PodMng software or 
third party application packages. 

 
1) From the main menu select the Configure menu option 
 
2) Select the Logging menu item to access the data recording operations setup screen. 

 
3)  Using the LoggingCfg setup dialog box (See Figure 22) simply enter the file name and directory 

location where you want to store the error log. Enter the error log file name in the space provided 
for this information. 

 
4)   Using the mouse pointer select the desired type of recording operations. 

 
Active: Data is recorded to a new file each time storage operations are activated. Old files are 

over written. 
 
Append: Data is appended to the end of the specified file at the resumption  of data recording 

operations. 
 

Move the mouse pointer over the data recording function tick boxes. Use the left mouse button to 
select the desired option. You can only select one option at any one time for either of the raw and 
processed data file. 

 
5) Once you have completed the setup operations select the OK button. The LoggingCfg Window 

will disappear and you will return to the default screen. 
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5.17 Network Error Report 

In order to provide a clear indication as to the operating characteristics for each instrument 
connected to a LAN a network reporting system has been created.  

To view the Error Report Window you should. 

1. Select the View menu option from the PodMng default screen. 

2. Select Error Tab on the Display Window. On selecting the Error tab the Error Display 
Window will appear. 

The Error Display Window is split into two parts. The top screen shows the instantaneous 
messages that are directed to the PodMng from the instruments. The bottom of the screen shows 
each instrument connected to the network and a real time summary of the network statistics. 

For each instrument connected to the LAN the following network statistics are reported: 

Packets Missed 
Packets Resent 
Packets Lost 
Status:              OK (Normal Operations)  Failed (Network time out, power failure)  
 
 

 

The Status message indicates the instantaneous action of the instruments. OK for successful operations 
and Failed for any instrument that have timed out or become disconnected.  

 

Instrument 
Names

Error Tab

Network Operation Statistics

Status Messages

 
Figure 26  Error Report Window 
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5.18 Hiding Error Screen From User  

 

It is not possible to have a perfect network where no packets will be lost. In order to prevent 
confusion with a user, a facility has been included with the driver software to remove the error log 
from a users screen. The error log is removed by a simple command included in the operating 
system registery. 

 

Remove error log from screen insert following command into Registery 

 

Command1= nopackerr 


